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1 Product overview

● Product views

● Product specifications

● Product hardware setup and software installation

For more information:

Go to www.hp.com/support/colorljM252.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Product views
● Product front view

● Product back view

● 2-line control-panel view (M252n model)

● Touchscreen control-panel view (M252dw model)

Product front view

8

9

5

1

7

6

3
2

4

1 2-line backlit control panel (M252n model)

Color touchscreen control panel (M252dw model, shown above)

2 Output bin

3 Walk-up USB port for printing without a computer (M252dw model)

4 Near field communication (NFC) internal antenna

5 Output bin extension

6 Front door (provides toner cartridge access)

7 Power on/off button

8 Single-sheet priority feed slot (Tray 1)

9 Main input tray (Tray 2)
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Product back view

2

1

5

4
3

6

1 Rear door (provides access for clearing jams)

2 Power connection

3 USB interface port

4 Ethernet port

5 Duplexer (duplex models only)

6 Serial number and product number label
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2-line control-panel view (M252n model)

1

2

43

5

6

1 2-line control panel display This screen displays menus and product information.

2 OK button Press the OK button for the following actions:

● Open the control-panel menus.

● Open a submenu displayed on the control-panel display.

● Select a menu item.

● Clear some errors.

● Begin a print job in response to a control-panel prompt (for example, when the 
message Press [OK] to continue appears on the control-panel display).

3 Left arrow  button Use this button to navigate through the menus or to decrease a value that appears on the 
display.

4 Right arrow  button Use this button to navigate through the menus or to increase a value that appears on the 
display.

5 Back arrow  button Use this button for the following actions:

● Exit the control-panel menus.

● Scroll back to a previous menu in a submenu list.

● Scroll back to a previous menu item in a submenu list (without saving changes to the 
menu item).

6 Cancel  button Press this button to cancel a print job or to exit the control panel menus.
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Touchscreen control-panel view (M252dw model)

4
5

3

2

1

1 Back  button Touch this button to return to the previous screen.

2 Home  button Touch this button to navigate to the Home screen.

3 Help  button Touch this button to open the control-panel help system.

4 Color touchscreen The display provides access to menus, help animations, and product information.

5 Home page screen indicator The display indicates which Home screen the control panel is currently displaying.

NOTE: While the control panel does not have a standard Cancel button, during many product processes a 
Cancel button appears on the touchscreen. This permits users to cancel a process before the product completes 
it.
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Home screen layout

The Home screen provides access to the product features and indicates the current status of the product.

Return to the Home screen at any time by touching the Home button on the product control panel.

NOTE: The features that appear on the Home screen can vary, depending on the product configuration.

5 67473

1 2

7
1 Reset button Touch this button to reset any temporary job settings to the 

default product settings.

2 Connection Information button Touch this button to open the Connection Information menu, 
which provides network information. The button appears as 

either a wired network icon  or a wireless network icon 

, depending on the type of network to which the product is 

connected.

3 Product status This screen area provides information about the overall product 
status.

4 USB  button Touch this button to open the USB Flash Drive menu.

5 Supplies  button Touch this button to view information about supplies status.

6 Apps  button Touch this button to open the Apps menu to print directly from 
select Web applications.

7 Setup  button Touch this button to open the Setup menu.
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How to use the touchscreen control panel

Use the following actions to use the product touchscreen control panel.

Action Description Example

Touch Touch an item on the screen to select that 
item or open that menu. Also, when 
scrolling through menus, briefly touch the 
screen to stop the scrolling.

Touch the Setup  button to open the 

Setup menu.

Swipe Touch the screen and then move the finger 
horizontally to move the screen sideways.

Swipe the Home screen to access the Setup 

 button.

Scroll Touch the screen, and then, without lifting 
the finger, move the finger vertically to 
move the screen.

Scroll through the Setup menu.
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Product specifications

Introduction

IMPORTANT: The following specifications are correct at the time of publication, but they are subject to change. 
For current information, see www.hp.com/support/colorljM252.

● Technical specifications

● Supported operating systems

● Mobile printing solutions

● Product dimensions

● Power consumption, electrical specifications, and acoustic emissions

● Operating-environment range

Technical specifications

Model name

Product number  

M252n

B4A21A

M252dw

B4A22A

Paper handling Single-sheet priority feed slot (Tray 1)

 Tray 2 (150-sheet capacity)

 Automatic duplex printing Not available

Connectivity 10/100/1000 Ethernet LAN connection with 
IPv4 and IPv6

 Hi-Speed USB 2.0

 Easy-access USB port Not available

 Print server for wireless network 
connectivity

Not available

 HP near field communication (NFC) and Wi-
Fi Direct for printing from mobile devices

Not available

Control-panel display and input 2-line backlit control panel Not available

 Color touchscreen control panel Not available

Print Prints 18 pages per minute (ppm) on A4 
and 19 ppm on letter-size paper

 Easy-access USB printing (no computer 
required)

Not available

Supported operating systems

The following information applies to the product-specific Windows PCL 6 and OS X print drivers and to the in-box 
software installation CD.

8 Chapter 1   Product overview ENWW

http://www.hp.com/support/colorljM252


Windows: The HP Software Installer CD installs the HP PCL.6 or HP PCL 6 driver depending on the Windows 
operating system along with optional software when using the full software installer.

Mac computers and OS X: Mac computers and Apple mobile devices are supported with this product. The OS X 
print driver and print utility are available for download from hp.com and may also be available via Apple Software 
Update. The HP installer software for OS X is not included in the in-box CD. Follow these steps to download the 
OS X installer software:

1. Go to www.hp.com/support/colorljM252.

2. Select Support Options, and then under Download Options select Drivers, Software & Firmware.

3. Click the operating system version, and then click the Download button.

Operating system Driver installed Notes

Windows® XP SP3 or later, 32-bit The “HP PCL 6” product-specific print driver 
is installed for this operating system as part 
of the basic software installation. The basic 
installer installs the driver only.

The full software installation is not 
supported for this operating system.

Use UPD drivers for 64-bit operating 
systems.

Microsoft retired mainstream support for 
Windows XP in April 2009. HP will continue 
to provide best effort support for the 
discontinued XP operating system.

Windows Vista®, 32-bit The “HP PCL 6” product-specific print driver 
is installed for this operating system as part 
of the basic software installation. The basic 
installer installs the driver only.

The full software installation is not 
supported for this operating system.

Use UPD drivers for 64-bit operating 
systems.

Windows Server 2003 SP2 or later, 32-bit The “HP PCL 6” product-specific print driver 
is installed for this operating system as part 
of the basic software installation. The basic 
installer installs the driver only.

The full software installation is not 
supported for this operating system.

Use UPD drivers for 64-bit operating 
systems.

Microsoft retired mainstream support for 
Windows Server 2003 in July 2010. HP will 
continue to provide best-effort support for 
the discontinued Server 2003 operating 
system.

Windows 7 SP1 or later, 32-bit and 64-bit The HP PCL 6 product-specific print driver is 
installed for this operating system as part of 
the full software installation.

 

Windows 8, 32-bit and 64-bit The HP PCL 6 product-specific print driver is 
installed for this operating system as part of 
the full software installation.

Windows 8 RT support is provided through 
Microsoft IN OS Version 4, 32- bit driver.

Windows 8.1, 32-bit and 64-bit The HP PCL 6 product-specific print driver is 
installed for this operating system as part of 
the full software installation.

Windows 8.1 RT support is provided through 
Microsoft IN OS Version 4, 32- bit driver.

Windows Server 2008 SP2, 32-bit The HP PCL.6 product-specific print driver is 
installed for this operating system as part of 
the basic software installation.

 

Windows Server 2008 SP2, 64-bit The HP PCL.6 product-specific print driver is 
installed for this operating system as part of 
the basic software installation.
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Operating system Driver installed Notes

Windows Server 2008 R2, SP 1, 64-bit The HP PCL 6 product-specific print driver is 
installed for this operating system as part of 
the full software installation.

 

Windows Server 2012, 64-bit The software installer does not support 
Windows Server 2012 but the HP PCL 6 and 
HP PCL-6 version 4 product-specific print 
drivers do support it.

Download the driver from the HP Web site 
www.hp.com/support/colorljM252, and use 
the Windows Add Printer tool to install it.

Windows Server 2012 R2, 64 bit The software installer does not support 
Windows Server 2012 but the HP PCL 6 and 
HP PCL-6 version 4 product-specific print 
drivers do support it.

Download the driver from the HP Web site 
www.hp.com/support/colorljM252, and use 
the Windows Add Printer tool to install it.

OS X 10.7 Lion, OS X 10.8 Mountain Lion, 
and OS X 10.9 Mavericks

The OS X print driver and print utility are 
available for download from hp.com and 
may also be available via Apple Software 
Update. The HP installer software for OS X is 
not included in the in-box CD.

For OS X, download the full installer from 
the support Web site for this product.

1. Go to www.hp.com/support/
colorljM252.

2. Select Support Options, and then 
under Download Options select 
Drivers, Software & Firmware.

3. Click the operating system version, 
and then click the Download button.

NOTE: For a current list of supported operating systems, go to www.hp.com/support/colorljM252 for HP's all-
inclusive help for the product.

NOTE: For details on client and server operating systems and for HP UPD PCL6, UPD PCL 5, and UPD PS driver 
support for this product, go to www.hp.com/go/upd and click the Specifications tab.

Mobile printing solutions

The product supports the following software for mobile printing:

● HP ePrint software

NOTE: The HP ePrint Software supports the following operating systems: Windows Vista® (32-bit and 64-
bit); Windows 7 SP 1 (32-bit and 64-bit); Windows 8 (32-bit and 64-bit); Windows 8.1 (32-bit and 64-bit); 
and OS X versions 10.6 Snow Leopard, 10.7 Lion, 10.8 Mountain Lion, and 10.9 Mavericks.

● HP ePrint via email (Requires HP Web Services to be enabled and the product to be registered with HP 
Connected)

● HP ePrint app (Available for Android, iOS, and Blackberry)

● ePrint Enterprise app (Supported on all products with ePrint Enterprise Server Software)

● HP All-in-One Remote app for iOS and Android devices

● Google Cloud Print

● AirPrint

● Android Printing

10 Chapter 1   Product overview ENWW

http://www.hp.com/support/colorljM252
http://www.hp.com/support/colorljM252
http://www.hp.com/support/colorljM252
http://www.hp.com/support/colorljM252
http://www.hp.com/support/colorljM252
http://www.hp.com/go/upd


Product dimensions

Figure 1-1  Dimensions for the M252n models

3 3

2

2

1 1

Product fully closed Product fully open

1. Height 236.2 mm (9.3 in) 236.2 mm (9.3 in)

2. Depth 384 mm (15.1 in) 849 mm (33.4 in)

3. Width 392 mm (15.4 in) 392 mm (15.4 in)

Weight (with cartridges) 13.4 kg (29.5 lb)

Figure 1-2  Dimensions for the M252dw models

3 3

2

2

1 1

 Product fully closed Product fully open

1. Height 236.2 mm (9.3 in) 285 mm (11.2 in)

2. Depth 417 mm (16.4 in) 1002 mm (39.4 in)

3. Width 392 mm (15.4 in) 392 mm (15.4 in)

Weight (with cartridges) 14.2 kg (31.5 lb)
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Power consumption, electrical specifications, and acoustic emissions

See www.hp.com/support/colorljM252 for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not convert 
operating voltages. This will damage the product and void the product warranty.

Operating-environment range

Table 1-1  Operating-environment specifications

Environment Recommended Allowed

Temperature 17° to 25°C (62.6° to 77°F) 15° to 30°C (59° to 86°F)

Relative humidity 30% to 70% relative humidity (RH) 10% to 80% RH
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Product hardware setup and software installation
For basic setup instructions, see the Hardware Installation Guide that came with the product. For additional 
instructions, go to HP support on the Web.

Go to www.hp.com/support/colorljM252 for HP's all-inclusive help for the product. Find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information

ENWW Product hardware setup and software installation 13
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2 Paper trays

● Load paper into the single-sheet slot (Tray 1)

● Load paper into Tray 2

For more information:

Go to www.hp.com/support/colorljM252.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information

ENWW 15
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Load paper into the single-sheet slot (Tray 1)

Introduction

Use the single-sheet priority feed slot to print single-page documents, documents that require multiple paper 
types, or envelopes.

● Load paper into the single-sheet priority feed slot

● Load an envelope in the single-sheet priority feed slot (Tray 1)

● Tray 1 paper orientation

Load paper into the single-sheet priority feed slot

1. Move the paper width guides in the single-sheet 
priority feed slot outward.

 

2. Place the top edge of the sheet at the opening, and 
then adjust the side guides so that they lightly 
touch the sheet, but do not bend it.
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3. Insert the single sheet into the slot and hold it. The 
product will pull the sheet partially into the paper 
path. For information about how to orient the 
paper, see Tray 1 paper orientation on page 19.

NOTE: Depending on the size of the paper, you 
might need to support the sheet with two hands 
until the sheet advances into the product.

 

4. At the computer, begin the printing process from 
the software application. Make sure that the driver 
is set to the correct paper type and size for the 
paper being printed from the single-sheet priority 
feed slot.

 

Load an envelope in the single-sheet priority feed slot (Tray 1)

1. Move the paper width guides in the single-sheet 
priority feed slot outward.
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2. Place the right edge of the envelope, face-up, at 
the opening, and then adjust the side guides so 
that they lightly touch the envelope, but do not 
bend it.

 

3. Insert the envelope into the slot and hold it. The 
product will pull the envelope partially into the 
paper path..

NOTE: Depending on the size of the envelope, 
you might need to support it with two hands until 
the envelope advances into the product.

 

4. At the computer, begin the printing process from 
the software application. Make sure that the driver 
is set to the correct paper type and size for the 
envelope being printed from the single-sheet 
priority feed slot.
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Tray 1 paper orientation

When using paper that requires a specific orientation, load it according to the information in the following table.

Paper type Output How to load paper

Letterhead or preprinted 1-sided printing Face-up

Top edge leading into the product

123

Letterhead or preprinted 2-sided printing Face-down

Top edge away from the product

123

Prepunched 1-sided printing or 2-sided printing Face-up

Holes toward the left side of the product
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Load paper into Tray 2

Introduction

The following information describes how to load paper in Tray 2.

● Load paper into Tray 2

● Load envelopes in Tray 2

● Tray 2 paper orientation

Load paper into Tray 2

1. Open the tray.  

2. Adjust the paper guides by sliding the guides to the 
size of the paper being used.
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3. To load legal-size paper, extend the tray front by 
pressing the blue latch and pulling the front of the 
tray.

NOTE: When loaded with legal-size paper, Tray 2 
extends from the front of the product 
approximately 51 mm (2 in).

 

4. Load paper into the tray.  
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5. Make sure that the paper stack is flat at all four 
corners. Slide the paper length and width guides so 
that they are against the stack of paper.

NOTE: To prevent jams, do not overfill the tray. 
Be sure that the top of the stack is below the tray 
full indicator.

 

6. After making sure that the paper stack is below the 
tray full indicator, close the tray.

 

Load envelopes in Tray 2

1. Open the tray.  
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2. Adjust the paper guides by sliding the guides to the 
size of the envelopes being used.

 

3. Load envelopes into the tray.  
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4. Make sure that the envelope stack is flat at all four 
corners. Slide the length and width guides so that 
they are against the stack.

NOTE: To prevent jams, do not overfill the tray. 
Be sure that the top of the stack is below the tray 
full indicator.

CAUTION: Loading more than five envelopes in 
Tray 2 can result in jams.

 

5. After making sure that the stack is below the tray 
full indicator, close the tray.
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Tray 2 paper orientation

When using paper that requires a specific orientation, load it according to the information in the following table.

Paper type Output How to load paper

Letterhead or preprinted 1-sided printing Face-up

Top edge toward the product

123

Letterhead or preprinted 2-sided printing Face-down

Top edge away from the product

123

Prepunched 1-sided printing or 2-sided printing Face-up

Holes toward the left side of the product
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3 Supplies, accessories, and parts

● Order supplies, accessories, and parts

● Replace the toner cartridges

For more information:

Go to www.hp.com/support/colorljM252.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Order supplies, accessories, and parts

Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on the computer, enter the 
product IP address or host name in the address/URL field. The EWS 
contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.

Supplies and accessories

Item Description Cartridge number Part number

Supplies

HP 201A Black Original LaserJet Toner 
Cartridge

Standard-capacity replacement black toner 
cartridge

201A CF400A

HP 201X High Yield Black Original 
LaserJet Toner Cartridge

High-capacity replacement black toner 
cartridge

201X CF400X

HP 201A Cyan Original LaserJet Toner 
Cartridge

Standard-capacity replacement cyan toner 
cartridge

201A CF401A

HP 201X High Yield Cyan Original 
LaserJet Toner Cartridge

High-capacity replacement cyan toner cartridge 201X CF401X

HP 201A Yellow Original LaserJet Toner 
Cartridge

Standard-capacity replacement yellow toner 
cartridge

201A CF402A

HP 201X High Yield Yellow Original 
LaserJet Toner Cartridge

High-capacity replacement yellow toner 
cartridge

201X CF402X

HP 201A Magenta Original LaserJet 
Toner Cartridge

Standard-capacity replacement magenta toner 
cartridge

201A CF403A

HP 201X High Yield Magenta Original 
LaserJet Toner Cartridge

High-capacity replacement magenta toner 
cartridge

201X CF403X

Accessories

USB 2.0 printer cable A-to-B cable (2-meter standard)  C6518A

Customer self-repair parts

Customer Self-Repair (CSR) parts are available for many HP LaserJet products to reduce repair time. More 
information about the CSR program and benefits can be found at www.hp.com/go/csr-support and 
www.hp.com/go/csr-faq.

Genuine HP replacement parts can be ordered at www.hp.com/buy/parts or by contacting an HP-authorized 
service or support provider. When ordering, one of the following will be needed: part number, serial number 
(found on back of printer), product number, or product name.
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● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are willing to pay 
HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is not 
provided under the HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request for no 
additional charge during the product warranty period.

Item Description
Self-replacement 
options Part number

Single-sheet priority feed slot tray Replacement tray for single-sheet priority feed 
slot (Tray 1)

Mandatory RM2-5865-000

150-sheet paper input tray Replacement cassette for Tray 2 Mandatory RM2-5885-000
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Replace the toner cartridges

Introduction

This product indicates when the toner cartridge level is low. The actual toner cartridge life remaining can vary. 
Consider having a replacement cartridge available to install when print quality is no longer acceptable.

To purchase cartridges or check cartridge compatibility for the product, go to HP SureSupply at www.hp.com/go/
suresupply. Scroll to the bottom of the page and verify that the country/region is correct.

The product uses four colors and has a different toner cartridge for each color: yellow (Y), magenta (M), cyan (C), 
and black (K). The toner cartridges are inside the front door.

Item Description Cartridge number Part number

HP 201A Black Original LaserJet Toner 
Cartridge

Standard-capacity replacement black toner 
cartridge

201A CF400A

HP 201X High Yield Black Original LaserJet 
Toner Cartridge

High-capacity replacement black toner 
cartridge

201X CF400X

HP 201A Cyan Original LaserJet Toner 
Cartridge

Standard-capacity replacement cyan toner 
cartridge

201A CF401A

HP 201X High Yield Cyan Original LaserJet 
Toner Cartridge

High-capacity replacement cyan toner 
cartridge

201X CF401X

HP 201A Yellow Original LaserJet Toner 
Cartridge

Standard-capacity replacement yellow toner 
cartridge

201A CF402A

HP 201X High Yield Yellow Original LaserJet 
Toner Cartridge

High-capacity replacement yellow toner 
cartridge

201X CF402X

HP 201A Magenta Original LaserJet Toner 
Cartridge

Standard-capacity replacement magenta 
toner cartridge

201A CF403A

HP 201X High Yield Magenta Original 
LaserJet Toner Cartridge

High-capacity replacement magenta toner 
cartridge

201X CF403X

Do not remove the toner cartridge from its package until it is time to install it.

CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. If 
the toner cartridge must be removed from the product for an extended period of time, place the cartridge in the 
original plastic packaging, or cover the cartridge with a light-weight, opaque item.

The following illustration shows the toner-cartridge components.
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2

1

3

1 Handle

2 Imaging drum

3 Memory chip

CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold water. Hot water 
sets toner into fabric.

NOTE: Information about recycling used toner cartridges is in the toner cartridge box.

Remove and replace the toner cartridges

1. Open the front door.  
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2. Grasp the blue handle on the toner cartridge 
drawer, and then pull out the drawer.

 

3. Grasp the handle on the toner cartridge, and then 
pull the toner cartridge straight up to remove it.

 

4. Remove the new toner cartridge package from the 
box, and then pull the release tab on the 
packaging.
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5. Remove the toner cartridge from the opened 
packaging shell.

 

6. Holding the toner on both ends, gently rock the 
toner cartridge end to end to distribute the toner 
evenly inside the cartridge.

 

7. Do not touch the imaging drum on the bottom of 
the toner cartridge. Fingerprints on the imaging 
drum can cause print-quality problems.
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8. Insert the new toner cartridge into the drawer. 
Make sure that the color chip on the cartridge 
matches the color chip on the drawer.

 

9. Close the toner cartridge drawer.  

10. Close the front door.  
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11. Place the used toner cartridge in the packaging 
from the new cartridge.

 

http://www.hp.com/recycle

12. Use the pre-paid self-addressed label to return the 
used cartridge to HP for recycling (where 
available).
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4 Print

● Print tasks (Windows)

● Print tasks (macOS)

● Mobile printing

● Use walk-up USB printing (touchscreen models only)

For more information:

Go to www.hp.com/support/colorljM252.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Print tasks (Windows)

How to print (Windows)

The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the product from the list of printers. To change settings, click or tap the Properties or Preferences 
button to open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and 
then select the printer.

3. Click or tap the tabs in the print driver to configure the available options. For example, set the paper 
orientation on the Finishing tab, and set the paper source, paper type, paper size, and quality settings on 
the Paper/Quality tab.
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4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from this 
screen.

5. Click or tap the OK button to print the job.

Automatically print on both sides (Windows)

Use this procedure for products that have an automatic duplexer installed. If the product does not have an 
automatic duplexer installed, or to print on paper types that the duplexer does not support, you can print on 
both sides manually.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and 
then select the printer.

3. Click or tap the Finishing tab.

4. Select the Print on both sides check box. Click the OK button to close the Document Properties dialog box.

5. In the Print dialog box, click the OK button to print the job.

Manually print on both sides (Windows) 

Use this procedure for products that do not have an automatic duplexer installed or to print on paper that the 
duplexer does not support.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and 
then select the printer.

3. Click or tap the Finishing tab.

4. Select the Print on both sides (manually) check box. Click the OK button to print the first side of the job.

5. Retrieve the printed stack from the output bin, and place it in Tray 1.

6. If prompted, touch the appropriate control panel button to continue.
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Print multiple pages per sheet (Windows)

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and 
then select the printer.

3. Click or tap the Finishing tab.

4. Select the number of pages per sheet from the Pages per sheet drop-down list.

5. Select the correct Print page borders, Page order, and Orientation options. Click the OK button to close the 
Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.

Select the paper type (Windows)

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and 
then select the printer.

3. Click or tap the Paper/Quality tab.

4. From the Paper type drop-down list, select the paper type that best describes the paper being used, and 
then click the OK button..

5. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.
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Print tasks (macOS)

How to print (macOS)

The following procedure describes the basic printing process for macOS.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then select other menus to adjust the print settings.

NOTE: The name of the item varies for different software programs.

4. Click the Print button.

Automatically print on both sides (macOS)

NOTE: This information applies to printers that include an automatic duplexer.

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using AirPrint.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Layout menu.

NOTE: The name of the item varies for different software programs.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (macOS)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using AirPrint.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Manual Duplex menu.

NOTE: The name of the item varies for different software programs.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the printer, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input 
tray.

8. If prompted, touch the appropriate control panel button to continue.
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Print multiple pages per sheet (macOS)

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Layout menu.

NOTE: The name of the item varies for different software programs.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the paper type (macOS)

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Media & Quality menu or the Paper/Quality menu.

NOTE: The name of the item varies for different software programs.

4. Select from the Media & Quality or Paper/Quality options.

NOTE: This list contains the master set of options available. Some options are not available on all 
printers.

● Media Type: Select the option for the type of paper for the print job.

● Print Quality: Select the resolution level for the print job.

● Edge-To-Edge Printing: Select this option to print close to the paper edges.

5. Click the Print button.
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Mobile printing

Introduction

HP offers multiple mobile and ePrint solutions to enable easy printing to an HP printer from a laptop, tablet, 
smartphone, or other mobile device. To see the full list and to determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting.

NOTE: Update the printer firmware to ensure all mobile printing and ePrint capabilities are supported.

● Wi-Fi Direct and NFC Printing (wireless models only)

● HP ePrint via email

● HP ePrint software

● AirPrint

● Android embedded printing

Wi-Fi Direct and NFC Printing (wireless models only)

Wi-Fi Direct and NFC (Near Field Communication) enable printing from a wireless mobile device without requiring 
a connection to a network or the Internet.

NFC capabilities enable easy one-to-one print connection for mobile devices using device-to-device touch.

Use Wi-Fi Direct to print wirelessly from the following devices:

● iPhone, iPad, or iPod touch using Apple AirPrint or the HP ePrint app

● Android mobile devices using the HP ePrint App or the Android embedded print solution

● PC and Mac devices using the HP ePrint Software

Enable or disable Wi-Fi Direct

Wi-Fi Direct capabilities must be enabled first from the product control panel.

1. From the Home screen on the product control panel, touch the Connection Information  button.

2. Open the following menus:

● Wi-Fi Direct

● Settings

● On/Off

3. Touch the On menu item. Touching the Off button disables Wi-Fi Direct printing.

For more information about wireless printing, go to www.hp.com/go/wirelessprinting.

For more information about how to print using Wi-Fi Direct, go to the product support home page: www.hp.com/
support/colorljM252.
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HP ePrint via email

Use HP ePrint to print documents by sending them as an email attachment to the product's email address from 
any email-enabled device.

To use HP ePrint, the product must meet these requirements:

● The product must be connected to a wired or wireless network and have Internet access.

● HP Web Services must be enabled on the product, and the product must be registered with HP Connected 
or HP ePrint Center.

2-line control panels

1. From the product control panel, press the OK button.

2. Open the following menus:

○ Network Setup

○ Show IP Address

3. To open the HP Embedded Web Server, enter the product IP address into the address line of a Web 
browser on the computer.

4. Click the HP Web Services tab on the HP Embedded Web Server, and then click Enable. The product 
enables Web Services, and then prints an information page.

The information page contains the printer code that you use to register the HP product at 
HP Connected.

5. Go to www.hpconnected.com or www.hp.com/go/eprintcenter to create an HP ePrint account and 
complete the ePrint via email setup process.

Touchscreen control panels

1. From the Home screen on the product control panel, touch the Connection Information 

button.

2. Open the following menus:

○ ePrint

○ Settings

○ Enable Web Services

3. Touch the Print button to read the terms of use agreement. Touch the OK button to accept the terms 
of use and enable HP Web Services

The product enables Web Services, and then prints an information page. The information page 
contains the printer code that you use to register this HP product at HP Connected or HP ePrint 
Center.

4. Go to www.hpconnected.com or www.hp.com/go/eprintcenter to create an HP ePrint account and 
complete the ePrint via email setup process.

Go to www.hp.com/support/colorljM252 to review additional support information for this product.
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HP ePrint software

The HP ePrint software makes it easy to print from a Windows or Mac desktop or laptop computer to any HP 
ePrint-capable printer. This software makes it easy to find HP ePrint-enabled printers that are registered to your 
HP Connected account. The target HP printer can be located in the office or at locations across the globe.

● Windows: After installing the software, open the Print option from within your application, and then select 
HP ePrint from the installed printers list. Click the Properties button to configure print options.

● macOS: After installing the software, select File, Print, and then select the arrow next to PDF (in the bottom 
left of the driver screen). Select HP ePrint.

For Windows, the HP ePrint software supports TCP/IP printing to local network printers on the network (LAN or 
WAN) to products that support UPD PostScript®.

Windows and macOS both support IPP printing to LAN or WAN network-connected products that support ePCL.

Windows and macOS also both support printing PDF documents to public print locations and printing using HP 
ePrint via email through the cloud.

Go to www.hp.com/go/eprintsoftware for drivers and information.

NOTE: For Windows, the name of the HP ePrint Software print driver is HP ePrint + JetAdvantage.

NOTE: The HP ePrint software is a PDF workflow utility for macOS, and is not technically a print driver.

NOTE: HP ePrint Software does not support USB printing.

AirPrint

Direct printing using Apple’s AirPrint is supported for iOS and from Mac computers running macOS 10.7 Lion and 
newer. Use AirPrint to print directly to the printer from an iPad, iPhone (3GS or later), or iPod touch (third 
generation or later) in the following mobile applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the printer must be connected to the same network (sub-net) as the Apple device. For more 
information about using AirPrint and about which HP printers are compatible with AirPrint, go to 
www.hp.com/go/MobilePrinting.

NOTE: Before using AirPrint with a USB connection, verify the version number. AirPrint versions 1.3 and earlier 
do not support USB connections.

Android embedded printing

HP's built-in print solution for Android and Kindle enables mobile devices to automatically find and print to HP 
printers that are either on a network or within wireless range for Wi-Fi Direct printing.

The print solution is built into the many versions of the operating system.
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NOTE: If printing is not available on your device, go to the Google Play > Android apps and install the HP Print 
Service Plugin.

For more information on how to use Android embedded printing and which Android devices are supported, go to 
www.hp.com/go/LaserJetMobilePrinting.
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Use walk-up USB printing (touchscreen models only)
1. Insert the USB flash drive into the walk-up USB port on the product.

2. The USB Flash Drive menu opens with the following options:

● Print Documents

● View and Print Photos

3. To print a document, touch the Print Documents screen, and then touch the name of the folder on the USB 
drive where the document is stored. When the summary screen opens, you can touch it to adjust the 
settings. Touch the Print button to print the document.

4. To print photos, touch the View and Print Photos screen, and then touch the preview image to select each 
photo that you want to print. Touch the Done button. When the summary screen opens, you can touch it to 
adjust the settings. Touch the Print button to print the photos.

5. Retrieve the printed job from the output bin, and remove the USB flash drive.
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5 Manage the product

● Use HP Web Services applications (touchscreen models only)

● Change the product connection type (Windows)

● Advanced configuration with HP Embedded Web Server (EWS) and HP Device Toolbox (Windows)

● Advanced configuration with HP Utility for OS X

● Configure IP network settings

● Product security features

● Economy settings

● HP Web Jetadmin

● Update the firmware

For more information:

Go to www.hp.com/support/colorljM252.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Use HP Web Services applications (touchscreen models only)
Several innovative applications are available for this product that you can download directly from the Internet. 
For more information and to download these applications go to the HP Connected Web site at 
www.hpconnected.com.

To use this feature, the product must be connected to a computer or network that has an Internet connection. 
HP Web Services must be enabled on the product.

1. From the Home screen on the product control panel, touch the Connection Information  button.

2. Open the following menus:

● ePrint

● Settings

3. Touch the Enable Web Services button.

After you download an application from the HP Connected Web site, it is available in the Apps menu on the 
product control panel. This process enables both HP Web Services and the Apps  button.
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Change the product connection type (Windows)
If you are already using the product and you wish to change the way it is connected, use the Reconfigure your HP 
Device shortcut on your computer desktop to change the connection. For example, you can reconfigure the 
product to use a different wireless address, to connect to a wired or wireless network, or change from a network 
connection to a USB connection. You can change the configuration without inserting the product CD. After you 
select the type of connection you wish to make, the program goes directly to the portion of the product setup 
procedure that needs to change.
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Advanced configuration with HP Embedded Web Server (EWS) and 
HP Device Toolbox (Windows)

Use the HP Embedded Web Server to manage printing functions from your computer instead of the product 
control panel.

● View product status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the product control-panel menu configuration

● View and print internal pages

● Receive notification of product and supplies events

● View and change network configuration

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP Embedded 
Web Server does not support IPX-based product connections. You do not have to have Internet access to open 
and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: HP Device Toolbox is available only if you performed a full installation when you installed the product. 
Depending on how the product is connected, some features might not be available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

Open the HP Embedded Web Server (EWS) from the Start menu

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Open the HP Embedded Web Server (EWS) from a Web browser

1. 2-line control panels: On the product control panel, press the OK button. Open the Network Setup menu, 
and then select Show IP Address to display the IP address or host name.

Touchscreen control panels: From the Home screen on the product control panel, touch the Connection 

Information  button, and then touch the Network Connected  button or the Network Wi-Fi 

ON  button to display the IP address or host name.

2. Open a Web browser, and in the address line, type the IP address or host name exactly as it displays on the 
product control panel. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the Web browser displays a There is a problem with this website’s security certificate message 
when attempting to open the EWS, click Continue to this website (not recommended).

Choosing Continue to this website (not recommended) will not harm the computer while navigating within 
the EWS for the HP product.
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Tab or section Description

Home tab

Provides product, status, and 
configuration information.

● Device Status: Shows the product status and shows the approximate percent life remaining 
of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies. Actual 
supply life remaining can vary. Consider having a replacement supply available to install 
when print quality is no longer acceptable. The supply does not need to be replaced unless 
the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration page.

● Network Summary: Shows the information found on the product network configuration 
page.

● Reports: Print the configuration and supplies status pages that the product generates.

● Event Log: Shows a list of all product events and errors.

System tab

Provides the ability to configure the 
product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Change the default paper-handling settings for the product.

● Print Quality: Change the default print-quality settings for the product.

● EcoSMART Console: Change the default times for entering Sleep mode or Auto Power Down 
mode. Configure which events cause the product to wake.

● Paper Types: Configure print modes that correspond to the paper types that the product 
accepts.

● System Setup: Change the system defaults for the product.

● Service: Perform the cleaning procedure on the product.

● Save and Restore: Save the current settings for the product to a file on the computer. Use 
this file to load the same settings onto another product or to restore these settings to this 
product at a later time.

● Administration: Set or change the product password. Enable or disable product features.

NOTE: The System tab can be password-protected. If this product is on a network, always 
consult with the administrator before changing settings on this tab.

Print tab

Provides the ability to change default 
print settings from your computer.

● Printing: Change the default product print settings, such as number of copies and paper 
orientation. These are the same options that are available on the control panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: Turn off or on the Print PS Errors feature.

Networking tab

(Network-connected products only)

Provides the ability to change network 
settings from your computer.

Network administrators can use this tab to control network-related settings for the product when 
it is connected to an IP-based network. It also allows the network administrator to set up Wireless 
Direct functionality. This tab does not appear if the product is directly connected to a computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.
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Advanced configuration with HP Utility for OS X
Use the HP Utility to check product status or to view or change product settings from your computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based 
network.

Open HP Utility

1. At the computer, open the System Preferences menu, and then click Print & Fax, Print & Scan, or Printers & 
Scanners.

2. Select the product in the list.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features

The HP Utility toolbar includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility.

● All Settings: Click this button to return to the HP Utility main view.

● HP Support: Click this button to open a browser and go to the HP support Web site.

● Supplies: Click this button to open the HP SureSupply Web site.

● Registration: Click this button to open the HP registration Web site.

● Recycling: Click this button to open the HP Planet Partners Recycling Program Web site.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the 
tasks that you can perform with HP Utility.

Item Description

Supplies Status Show the product supplies status and provides links for ordering supplies online.

Device Information Show information about the currently selected product, including the product Service ID (if 
assigned), the firmware version (FW Version), the Serial Number, and the IP address.

Commands Send special characters or print commands to the product after the print job.

NOTE: This option is available only after you open the View menu and select the Show 
Advanced Options item.

Color Usage

(Color products only)

Show information about color jobs that the product has produced.
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Item Description

File Upload Transfer files from the computer to the product. You can upload the following types of files:

○ HP LaserJet printer command language (.PRN)

○ Portable document format (.PDF)

○ Postscript (.PS)

○ Text (.TXT)

Power Management Configure the product economy settings.

Update Firmware Transfer a firmware update file to the product.

NOTE: This option is available only after you open the View menu and select the Show 
Advanced Options item.

HP Connected Access the HP Connected Web site.

Upload Fonts Upload fonts from the computer to the product.

Message Center Display error events that have occurred with the product.

Duplex Mode Turn on the automatic two-sided printing mode.

Network Settings

(Network-connected products only)

Configure the network settings, such as the IPv4 settings, IPv6 settings, Bonjour settings, 
and other settings.

Supplies Management Configure how the product should behave when supplies are nearing the end of their 
estimated life.

Trays Configuration Change paper size and type for each of the trays.

Additional Settings Open the HP Embedded Web Server (EWS) for the product.

NOTE: USB connections are not supported.

Proxy Server Settings Configure a proxy server for the product.

Basic Fax Settings

(MFP fax models only)

Set up the fields in the fax header and configure how the product answers incoming calls.

Fax Forwarding

(MFP fax models only)

: Set up the product to send the incoming faxes to a different number.

Fax Logs

(MFP fax models only)

View the logs of all faxes.

Fax Speed Dials

(MFP fax models only)

Add fax numbers to the speed dial list.

Junk Fax Blocking

(MFP fax models only)

Store the fax numbers you want to block.

Scan to E-mail

(MFP products only)

Open the HP Embedded Web Server (EWS) page for configuring settings for scanning to 
email.

Scan to Network Folder

(MFP products only)

Open the HP Embedded Web Server (EWS) page for configuring settings for scanning to a 
network folder.
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Configure IP network settings

Introduction

Use the following sections to configure the product network settings.

● Printer sharing disclaimer

● View or change network settings

● Rename the product on a network

● Manually configure IPv4 TCP/IP parameters from the control panel

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and 
not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.

1. Open the HP Embedded Web Server (EWS):

a. 2-line control panels: On the product control panel, press the OK button. Open the Network Setup 
menu, and then select Show IP Address to display the IP address or host name.

Touchscreen control panels: From the Home screen on the product control panel, touch the 

Connection Information  button, and then touch the Network Connected  button or 

the Network Wi-Fi ON  button to display the IP address or host name.

b. Open a Web browser, and in the address line, type the IP address or host name exactly as it displays 
on the product control panel. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the Web browser displays a There is a problem with this website’s security certificate 
message when attempting to open the EWS, click Continue to this website (not recommended).

Choosing Continue to this website (not recommended) will not harm the computer while navigating 
within the EWS for the HP product.

2. Click the Networking tab to obtain network information. Change settings as needed.

Rename the product on a network

If you want to rename the product on a network so that it can be uniquely identified, use the HP Embedded Web 
Server.

1. Open the HP Embedded Web Server (EWS):

56 Chapter 5   Manage the product ENWW

http://www.microsoft.com


a. 2-line control panels: On the product control panel, press the OK button. Open the Network Setup 
menu, and then select Show IP Address to display the IP address or host name.

Touchscreen control panels: From the Home screen on the product control panel, touch the 

Connection Information  button, and then touch the Network Connected  button or 

the Network Wi-Fi ON  button to display the IP address or host name.

b. Open a Web browser, and in the address line, type the IP address or host name exactly as it displays 
on the product control panel. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the Web browser displays a There is a problem with this website’s security certificate 
message when attempting to open the EWS, click Continue to this website (not recommended).

Choosing Continue to this website (not recommended) will not harm the computer while navigating 
within the EWS for the HP product.

2. Open the System tab.

3. On the Device Information page, the default product name is in the Device Status field. You can change this 
name to uniquely identify this product.

NOTE: Completing the other fields on this page is optional.

4. Click the Apply button to save the changes.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

2-line control panels

1. On the product control panel, press the OK button.

2. Open the following menus:

● Network Setup

● TCP/IP configuration

● Manual

3. Use the arrow keys and the OK button to enter the IP address, subnet mask, and default gateway, and then 
touch the OK button to save the changes.

Touchscreen control panels

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Network Setup

● TCP/IP configuration

● Manual
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3. Use the keypad on the touchscreen to enter the IP address, and touch the OK button. Touch the Yes button 
to confirm.

4. Use the keypad on the touchscreen to enter the subnet mask, and touch the OK button. Touch the Yes 
button to confirm.

5. Use the keypad on the touchscreen to enter the default gateway, and touch the OK button. Touch the Yes 
button to confirm.
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Product security features

Introduction

The product includes several security features to restrict who has access to configuration settings, to secure 
data, and to prevent access to valuable hardware components.

● Assign or change the system password using the HP Embedded Web Server

Assign or change the system password using the HP Embedded Web Server

Assign an administrator password for access to the product and the HP Embedded Web Server so that 
unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server (EWS):

a. 2-line control panels: On the product control panel, press the OK button. Open the Network Setup 
menu, and then select Show IP Address to display the IP address or host name.

Touchscreen control panels: From the Home screen on the product control panel, touch the 

Connection Information  button, and then touch the Network Connected  button or 

the Network Wi-Fi ON  button to display the IP address or host name.

b. Open a Web browser, and in the address line, type the IP address or host name exactly as it displays 
on the product control panel. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the Web browser displays a There is a problem with this website’s security certificate 
message when attempting to open the EWS, click Continue to this website (not recommended).

Choosing Continue to this website (not recommended) will not harm the computer while navigating 
within the EWS for the HP product.

2. Click the Security tab.

3. Open the General Security menu.

4. In the area labeled Set the Local Administrator Password, enter the name to associate with the password in 
the Username field.

5. Enter the password in the New Password field, and then enter it again in the Verify Password field.

NOTE: To change an existing password, first enter the existing password in the Old Password field.

6. Click the Apply button.

NOTE: Make note of the password and store it in a safe place.
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Economy settings

Introduction

The product includes several economy features to conserve energy and supplies.

● Print with EconoMode

● Configure the Sleep/Auto Off After setting

● Set the Shut Down After delay and configure the product to use 1 watt or less of power

● Configure the Delay Shut Down setting

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. 
However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might 
outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, 
consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web Server.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Configure the Sleep/Auto Off After setting

2-line control panels

1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep/Auto Off After

3. Use the arrow keys to select the time for the Sleep/Auto Off After delay, and then press the OK button.

Touchscreen control panels

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:
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● System Setup

● Energy Settings

● Sleep/Auto Off After

3. Select the time for the Sleep/Auto Off After delay.

Set the Shut Down After delay and configure the product to use 1 watt or less of power

NOTE: After the product shuts down, the power consumption is 1 watt or less.

2-line control panels

1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Energy Settings

● Shut Down After

3. Select the time for the Shut Down After delay.

NOTE: The default value is 4 hours.

Touchscreen control panels

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Shut Down After

3. Select the time for the Shut Down After delay.

NOTE: The default value is 4 hours.

Configure the Delay Shut Down setting

2–line control panels

1. On the product control panel, press the OK button.

2. Open the following menus:
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● System Setup

● Energy Settings

● Delay Shut Down

3. Select one of the delay options:

● No Delay: The product shuts down after a period of inactivity determined by the Shut Down After 
setting.

● When Ports Are Active: When this option is selected the product will not shut down unless all ports 
are inactive. An active network link or fax connection will prevent the product from shutting down.

Touchscreen control panels

1. On the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Delay Shut Down

3. Select one of the delay options:

● No Delay: The product shuts down after a period of inactivity determined by the Shut Down After 
setting.

● When Ports Are Active: When this option is selected the product will not shut down unless all ports 
are inactive. An active network link will prevent the product from shutting down.
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HP Web Jetadmin
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of 
networked HP products, including printers, multifunction products, and digital senders. This single solution 
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging 
environment — ultimately increasing business productivity by helping you save time, control costs, and protect 
your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features. Go 
to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about upgrades.
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Update the firmware
HP offers periodic product updates, new Web Services apps, and new features to existing Web Services apps. 
Follow these steps to update the product firmware for a single product. When you update the firmware, Web 
Service apps will update automatically.

There are two supported methods to perform a firmware update on this product. Use only one of the following 
methods to update the product firmware.

Method one: Update the firmware using the control panel

Use these steps to load the firmware from the control panel (for network-connected products only), and/or set 
the product to automatically load future firmware updates. For USB-connected products, skip to method two.

1. Make sure the product is connected to a wired (Ethernet) or wireless network with an active Internet 
connection.

NOTE: The product must be connected to the internet to update the firmware via a network connection.

2. From the Home screen on the product control panel, open the Setup menu.

● For touchscreen control panels, touch the Setup  button.

● For standard control panels, press the left or right arrow button.

3. Scroll to and open the Service menu, and then open the LaserJet Update menu.

NOTE: If the LaserJet Update option is not listed, use method two.

4. Check for updates.

● For touchscreen control panels, touch Check for Updates Now.

● For standard control panels, select Check for Update.

NOTE: The product automatically checks for an update, and if a newer version is detected, the update 
process automatically starts.

5. Set the product to automatically update the firmware when updates become available.

From the Home screen on the product control panel, open the Setup menu.

● For touchscreen control panels, touch the Setup  button.

● For standard control panels, press the left or right arrow button.

Scroll to and open the Service menu, open the LaserJet Update menu, and then select the Manage Updates 
menu.

Set the product to automatically update the firmware.

● For touchscreen control panels, set the Allow Updates option to YES, and then set the Check 
automatically option to ON.

● For standard control panels, set the Allow Updates option to YES, and then set the Automatic Check 
option to ON.
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Method two: Update the firmware using the Firmware Update Utility

Use these steps to manually download and install the Firmware Update Utility from HP.com.

NOTE: This method is the only firmware update option available for products connected to the computer via a 
USB cable. It also works for products connected to a network.

1. Go to www.hp.com/go/support, click the Drivers & Software link, type the product name in the search field, 
press the ENTER button, and then select the product from the list of search results.

2. Select the operating system.

3. Under the Firmware section, locate the Firmware Update Utility.

4. Click Download, click Run, and then click Run again.

5. When the utility launches, select the product from the drop-down list, and then click Send Firmware.

NOTE: To print a configuration page to verify the installed firmware version before or after the update 
process, click Print Config.

6. Follow the on-screen instructions to complete the installation, and then click the Exit button to close the 
utility.
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6 Solve problems

● Customer support

● Control panel help system (touchscreen models only)

● Restore the factory-set defaults

● A “Cartridge is low” or “Cartridge is very low” message displays on the product control panel

● Product does not pick up paper or misfeeds

● Clear paper jams

● Improve print quality

● Solve wired network problems

● Solve wireless network problems

For more information:

Go to www.hp.com/support/colorljM252.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase, and 
problem description ready

Country/region phone numbers are on the flyer that was in the box 
with your product or at www.hp.com/support/

Get 24-hour Internet support, and download software utilites and 
drivers

www.hp.com/support/colorljM252

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Control panel help system (touchscreen models only)
The product has a built-in Help system that explains how to use each screen. To open the Help system, touch the 
Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse 
through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for that 
screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that describes the 

problem. The message also contains instructions to help solve the problem.
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Restore the factory-set defaults
Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It will 
not reset the page count, tray size, or language. To restore the product to the factory-default settings, follow 
these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also 
deletes any pages that are stored in the memory.

1. 2-line control panels: On the product control panel, press the OK button.

Touchscreen control panels: From the Home screen on the product control panel, touch the Setup 

button.

2. Open the Service menu.

3. Select the Restore Defaults option, and then press or touch the OK button.

The product automatically restarts.
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A “Cartridge is low” or “Cartridge is very low” message displays on 
the product control panel

Cartridge is low: The product indicates when a toner cartridge level is low. Actual toner cartridge life remaining 
may vary. Consider having a replacement available to install when print quality is no longer acceptable. The toner 
cartridge does not need to be replaced now.

Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print 
quality. To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back 
and forth end to end. Reinsert the toner cartridge into the printer and close the cover.

Cartridge is very low: The product indicates when the toner cartridge level is very low. Actual toner cartridge life 
remaining may vary. To extend the life of the toner, gently rock the cartridge back and forth end to end. Consider 
having a replacement available to install when print quality is no longer acceptable. The toner cartridge does not 
need to be replaced now unless the print quality is no longer acceptable.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner cartridge has 
ended.

Change the “Very Low” settings

You can change the way the product reacts when supplies reach the Very Low state. You do not have to re-
establish these settings when you install a new toner cartridge.

1. 2-line control panels: On the product control panel, press the OK button.

Touchscreen control panels: From the Home screen on the product control panel, touch the Setup 

button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Setting

3. Select one of the following options:
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● Select the Continue option to set the product to alert you that the toner cartridge is very low, but to 
continue printing.

● Select the Stop option to set the product to stop printing until you replace the toner cartridge.

● Select the Prompt option to set the product to stop printing and prompt you to replace the toner 
cartridge. You can acknowledge the prompt and continue printing. A customer configurable option on 
this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never." This 
option is provided as a customer convenience and is not an indication these pages will have 
acceptable print quality.

Order supplies

Order supplies and paper www.hp.com/go/suresupply

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter the 
product IP address or host name in the address/URL field. The EWS 
contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.
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Product does not pick up paper or misfeeds

Introduction

The following solutions can help solve problems if the product is not picking up paper from the tray or is picking 
up multiple sheets of paper at one time.

● The product does not pick up paper

● The product picks up multiple sheets of paper

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed 
the paper manually. Load paper, and continue.

6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with 
warm water.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.
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Clear paper jams

Introduction

The following information includes instructions for clearing paper jams from the product.

● Experiencing frequent or recurring paper jams?

● Paper jam locations

● Clear paper jams in the single-sheet slot (Tray 1)

● Clear paper jams in Tray 2

● Clear paper jams in the rear door and the fuser area

● Clear paper jams in the output bin 

● Clear paper jams in the duplexer (duplex models only)

Experiencing frequent or recurring paper jams?

Follow these steps to solve problems with frequent paper jams. If the first step does not resolve the problem 
continue with the next step until you have resolved the problem.

1. If paper has jammed in the product, clear the jam and then print a configuration page to test the product.

2. Check that the tray is configured for the correct paper size and type on the product control panel. Adjust 
paper settings if necessary.

a. 2-line control panels: On the product control panel, press the OK button.

Touchscreen control panels: From the Home screen on the product control panel, touch the Setup 

button.

b. Open the System Setup menu.

c. Open the Paper setup menu.

d. Select the tray from the list.

e. Select Paper Type and then select the type of paper that is in the tray.

f. Select Paper Size and then select the size of paper that is in the tray.

3. Turn the product off, wait 30 seconds, and then turn it on again.

4. Print a cleaning page to remove excess toner from inside the product.

a. 2-line control panels: On the product control panel, press the OK button.

Touchscreen control panels: From the Home screen on the product control panel, touch the Setup 

button.

b. Open the Service menu.

c. Select Cleaning Page.
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d. Load plain letter or A4 paper when you are prompted.

e. Touch the OK button to begin the cleaning process.

The product prints the first side and then prompts you to remove the page from the output bin and 
reload it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the page 
that prints.

5. Print a configuration page to test the product.

a. 2-line control panels: On the product control panel, press the OK button.

Touchscreen control panels: From the Home screen on the product control panel, touch the Setup 

button.

b. Open the Reports menu.

c. Select Configuration Report.

If none of these steps resolves the problem, the product might need service. Contact HP customer support.

Paper jam locations

5

1

2

3

4

1 Output bin See Clear paper jams in the output bin on page 83.

2 Single-sheet priority feed 
slot (Tray 1)

See Clear paper jams in the single-sheet slot (Tray 1) on page 76.

3 Tray 2 See Clear paper jams in Tray 2 on page 78.

4 Rear door and fuser area See Clear paper jams in the rear door and the fuser area on page 81.

5 Duplexer (duplex models 
only)

See Clear paper jams in the duplexer (duplex models only) on page 84.
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Clear paper jams in the single-sheet slot (Tray 1)

When a jam occurs, the control panel displays an error message (2-line control panels) or an animation 
(touchscreen control panels) that assists in clearing the jam.

1. Pull Tray 2 completely out of the product.  

2. Push down on the single-sheet priority feed slot, 
and then pull out the feed slot tray.

 

3. Gently pull any jammed paper straight out of the 
single-sheet priority feed slot.
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4. Push the single-sheet priority feed slot tray into 
the product.

 

5. Reinsert and close Tray 2.  
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Clear paper jams in Tray 2

Use the following procedure to check for a paper jam in Tray 2. When a jam occurs, the control panel displays an 
error message (2-line control panels) or an animation (touchscreen control panels) that assists in clearing the 
jam.

1. Pull the tray completely out of the product.  

2. Remove any jammed or damaged sheets of paper.  
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3. If no jammed paper is visible, or if jammed paper is 
deep enough in the Tray 2 cavity that it is difficult 
to remove, press down on the single-sheet priority 
feed slot, and then remove the feed slot tray.

 

4. Remove any jammed or damaged sheets of paper.  
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5. Push the single-sheet priority feed slot tray into 
the product.

 

6. Reinsert and close Tray 2.  
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Clear paper jams in the rear door and the fuser area

Use the following procedure to check for paper inside the rear door. When a jam occurs, the control panel 
displays an error message (2-line control panels) or an animation (touchscreen control panels) that assists in 
clearing the jam.

CAUTION: The fuser is located above the rear door, and it is hot. Do not attempt to reach into the area above 
the rear door until the fuser is cool.

1. Open the rear door.  
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2. Gently pull out any jammed paper from the rollers 
in the rear door area.

 

3. Close the rear door.  
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Clear paper jams in the output bin 

Use the following procedure to clear jams in the output bin. When a jam occurs, the control panel displays an 
error message (2-line control panels) or an animation (touchscreen control panels) that assists in clearing the 
jam.

1. If paper is visible in the output bin, grasp the 
leading edge and remove it.
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Clear paper jams in the duplexer (duplex models only)

Use the following procedure to check for paper in the duplexer. When a jam occurs, the control panel displays an 
error message (2-line control panels) or an animation (touchscreen control panels) that assists in clearing the 
jam.

1. At the rear of the product, open the duplexer.  
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2. Remove any jammed or damaged sheets of paper.

CAUTION: The fuser is located above the rear 
door, and it is hot. Do not attempt to reach into the 
area above the rear door until the fuser is cool.

 

3. Close the duplexer.  
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Improve print quality

Introduction

If the product is having print-quality problems, try the following solutions in the order presented to resolve the 
issue.

● Print from a different software program

● Check the paper-type setting for the print job

● Check toner-cartridge status

● Print and interpret the print quality page

● Clean the product

● Visually inspect the toner cartridge

● Check paper and the printing environment

● Adjust color settings (Windows)

● Calibrate the product to align the colors

● Check the EconoMode settings

● Try a different print driver

Print from a different software program

Try printing from a different software program. If the page prints correctly, the problem is with the software 
program from which you were printing.

Check the paper-type setting for the print job

Check the paper type setting when printing from a software program and the printed pages have smears, fuzzy 
or dark print, curled paper, scattered dots of toner, loose toner, or small areas of missing toner.

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.
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Check the paper type setting (OS X)

1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then click the Media & Quality menu or the Paper/Quality menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Check toner-cartridge status

Follow these steps to check the estimated life remaining in the toner cartridges and if applicable, the status of 
other replaceable maintenance parts.

Step one: Print the supplies status page (2-line control panels)

1. On the product control panel, press the OK button.

2. Scroll to the Reports menu, and then press the OK button.

3. Scroll to the Supplies Status menu, and then press the OK button.

4. Scroll to the Print Supplies status page item, and then press the OK. button

Step one: Print the supplies status page (touchscreen control panels)

1. From the Home screen on the product control panel, navigate to and touch the Supplies  button.

2. Touch the Report button to print the supplies status page.

3. To print a report of the status of all supply items, including the genuine HP part number for reordering the 
supply, select Manage Supplies, and then select Print Supplies Status.

Step two: Check supplies status

1. Look at the supplies status report to check the percent of life remaining for the toner cartridges and if 
applicable, the status of other replaceable maintenance parts.

Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The 
supplies status page indicates when a supply level is very low. After an HP supply has reached the very low 
threshold, HP’s premium protection warranty on that supply has ended.

The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable. 
Consider having a replacement available to install when print quality is no longer acceptable.

If you determine that you need to replace a toner cartridge or other replaceable maintenance parts, the 
supplies status page lists the genuine HP part numbers.

2. Check to see if you are using a genuine HP cartridge.

A genuine HP toner cartridge has the words “HP” on it, or has the HP logo on it. For more information on 
identifying HP cartridges go to www.hp.com/go/learnaboutsupplies.
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Print and interpret the print quality page

1. 2-line control panels: On the product control panel, press the OK button.

Touchscreen control panels: From the Home screen, touch the Setup  button.

2. Open the Reports menu.

3. Select the Print Quality Page item.

This page contains five bands of color, which are divided into four groups as indicated in the following illustration. 
By examining each group, you can isolate the problem to a particular toner cartridge.

Section Toner cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the toner cartridge that correlates with that 
group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem, determine 
if the dots are always the same color; for example, if magenta dots appear in all five color bands. If the dots 
are all the same color, replace that toner cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the toner cartridge is 
probably causing the problem.

Clean the product
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Print a cleaning page

2-line control panels

1. From the product control panel, press the OK button.

2. Open the Service menu.

3. Use the arrow keys to select the Cleaning mode option, and then press the OK button.

The product prints the first side and then prompts you to remove the page from the output bin and reload 
it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the page that prints.

Touchscreen control panels

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Cleaning Page button.

4. Load plain letter or A4 paper when you are prompted.

5. Touch the OK button to begin the cleaning process.

The product prints the first side and then prompts you to remove the page from the output bin and reload 
it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the page that prints.

Visually inspect the toner cartridge

Follow these steps to inspect each toner cartridge.

1. Remove the toner cartridge from the product.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum.

CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality 
problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.

5. Reinstall the toner cartridge, and print a few pages to see if the problem has resolved.

Check paper and the printing environment

Step one: Use paper that meets HP specifications

Some print-quality problems arise from using paper that does not meet HP specifications.

● Always use a paper type and weight that this product supports.

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, 
staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that does not contain metallic material, such as glitter.
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● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet 
printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Step two: Check the environment

The environment can directly affect print quality and is a common cause for print-quality or paper-feeding 
issues. Try the following solutions:

● Move the product away from drafty locations, such as open windows or doors, or air-conditioning vents.

● Make sure the product is not exposed to temperatures or humidity outside of product specifications.

● Do not place the product in a confined space, such as a cabinet.

● Place the product on a sturdy, level surface.

● Remove anything that is blocking the vents on the product. The product requires good air flow on all sides, 
including the top.

● Protect the product from airborne debris, dust, steam, grease, or other elements that can leave residue 
inside the product.

Adjust color settings (Windows)

Follow these steps if colors on the printed page to not match colors on the computer screen, or if the colors on 
the printed page are not satisfactory.

Change the color theme

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this 
theme, manage color in the software program or in the operating system for correct rendering.

● Vivid (sRGB): The product increases the color saturation in the midtones. Use this theme when 
printing business graphics.

● Photo (sRGB): The product interprets RGB color as if it were printed as a photograph using a digital 
mini lab. The product renders deeper, more saturated colors differently than with the Default (sRBG) 
theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color 
space rather than sRGB. Turn off color management in the software program when using this theme.
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● None: No color theme is used.

● Custom Profile: Select this option to use a custom input profile to accurately control color output (for 
example, to emulate a specific HP Color LaserJet product). Download custom profiles from 
www.hp.com.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.

Change the color options

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independently from other settings. Click 
the Settings button to open the manual color-adjusment window.

NOTE: Changing color settings manually can impact output. HP recommends that only color 
graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this option to 
print color documents for photocopying or faxing. Also use this option to print draft copies or to save color 
toner.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.

Calibrate the product to align the colors

Calibration is a product function that optimizes print quality.

Follow these steps to resolve print-quality problems such as misaligned color, colored shadows, blurry graphics, 
or other print-quality issues.

2-line control panels

1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Print Quality

● Color Calibration

● Calibrate Now
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3. Press the OK button to start the calibration process.

A Calibrating message will display on the product control panel. The calibration process takes a few 
minutes to complete. Do not turn the product off until the calibration process has finished.

4. Wait while the product calibrates, and then try printing again.

Touchscreen control panels

1. On the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Print Quality

● Color Calibration

● Calibrate Now

3. A Calibrating message will display on the product control panel. The calibration process takes a few 
minutes to complete. Do not turn the product off until the calibration process has finished.

4. Wait while the product calibrates, and then try printing again.

Check the EconoMode settings

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might 
outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, 
consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, you can 
enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab, and locate the Print Quality area.

4. If the entire page is too dark, use these settings:

● Select the 600 dpi option.

● Select the EconoMode check box to enable it.

If the entire page is too light, use these settings:

● Select the FastRes 1200 option.

● Clear the EconoMode check box to disable it.

5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click the OK button to 
print the job.
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Try a different print driver

Try a different print driver when printing from a software program and the printed pages have unexpected lines 
in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

Download any of the following drivers from the HP Web site: www.hp.com/support/colorljM252.

HP PCL 6 driver ● Provided as the default driver on the product CD. This driver is automatically installed 
unless you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for most 
users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed 
in Windows environments

● Might not be fully compatible with third-party and custom software programs that 
are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly 
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript flash 
font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the product 
to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for 
use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows 
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for most 
users

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in 
Windows environments

● Might not be fully compatible with third-party and custom software programs that 
are based on PCL 5
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Solve wired network problems

Introduction

Check the following items to verify that the product is communicating with the network. Before beginning, print a 
configuration page from the product control panel and locate the product IP address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating 
systems and not of the HP print drivers. For more information, go to Microsoft at www.microsoft.com.

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity light and 
the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is 
selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to this 
printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP 
address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer.
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● For Windows, click Start, click Run, type cmd, and then press Enter.

● For OS X, go to Applications, then Utilities, and open Terminal.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, 
the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

HP recommends leaving these settings in automatic mode (the default setting). If you change these settings, 
you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, print drivers, and the network redirection settings.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems

Introduction

Use the troubleshooting information to help resolve issues.

NOTE: To determine whether HP NFC and HP wireless direct printing are enabled on your product, print a 
configuration page from the product control panel. If a page titled Wireless is included, HP Jetdirect 2800w NFC 
& Wireless Direct Accessory printing is enabled on the product.

● Wireless connectivity checklist

● The product does not print after the wireless configuration completes

● The product does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or product

● Cannot connect more computers to the wireless product

● The wireless product loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

● Perform a wireless network diagnostic test

● Reduce interference on a wireless network

Wireless connectivity checklist

● Verify that the network cable is not connected.

● Verify that the product and the wireless router are turned on and have power. Also make sure that the 
wireless radio in the product is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you 
are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is 
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network. If the 
network has Internet access, try connecting to the Internet over a wireless connection.

● Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless access 
point (on networks using WPA security).

● Verify that the product is within the range of the wireless network. For most networks, the product must be 
within 30 m (100 ft) of the wireless access point (wireless router).

● Verify that obstacles do not block the wireless signal. Remove any large metal objects between the access 
point and the product. Make sure poles, walls, or support columns containing metal or concrete do not 
separate the product and wireless access point.
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● Verify that the product is located away from electronic devices that might interfere with the wireless signal. 
Many devices can interfere with the wireless signal including motors, cordless phones, security system 
cameras, other wireless networks, and some Bluetooth devices.

● Verify that the print driver is installed on the computer.

● Verify that you have selected the correct printer port.

● Verify that the computer and product connect to the same wireless network.

● For OS X, verify that the wireless router supports Bonjour.

The product does not print after the wireless configuration completes

1. Make sure that the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.

5. Verify that you can open the product HP Embedded Web Server from a computer on the network.

The product does not print, and the computer has a third-party firewall installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you allow the 
programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the firewall 
when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product

1. Make sure that the router or product connects to the same network that your computer connects to.

2. Print a configuration page.

3. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer configuration 
for the computer.

4. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the 
wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. 
For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure that the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart the computer.
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The wireless product loses communication when connected to a VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer.

● For Windows, click Start, click Run, type cmd, and then press Enter.

● For OS X, go to Applications, then Utilities, and open Terminal.

b. Type ping followed by the router IP address.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer 
configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure 
the wireless setup for the product.

Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the wireless 
network settings.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the Self Diagnostics menu.

3. Touch the Run Wireless Test button to start the test. The product prints a test page that shows test results.

Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:
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● Keep the wireless devices away from large metal objects, such as filing cabinets, and other 
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt radio 
signals.

● Keep the wireless devices away from large masonry structures and other building structures. These objects 
can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the network.
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